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Introduction 
 

 

 

A l’heure actuelle, les nouveau-nés atteints de fente labio-palatines représentent 1 
naissance sur 700 en France, avec des variations ethniques et géographiques. Ce 
sont les malformations congénitales orofaciales les plus fréquentes au monde. [15] 

Leur étiologie est mal connue, vraisemblablement plurifactorielle par l’interaction de 
facteurs génétiques et environnementaux. Il en résulte un défaut de fusion entre les 
bourgeons faciaux formant la lèvre supérieure et le palais ou entre les lames 
palatines lors du développement du palais secondaire. [1,15] 

La prise en charge primaire comprend une chirurgie de fermeture de la lèvre et une 
autre du palais selon deux calendriers thérapeutiques principaux, en fonction des 
équipes. [1] 

Avant la chirurgie vélo-palatine, certaines équipes ont recours à l’utilisation de 
plaques palatines obturatrices pour améliorer les troubles alimentaires, la fonction 
linguale et la succion. En effet, ces orthèses éviteraient l’interposition linguale dans 
la fente palatine, améliorant le confort alimentaire et limitant la déformation palatine. 
[16] 

Habituellement, les plaques d’obturation sont réalisées par plaques 
thermoformables (ethylvinylacétate, polyester) ou en résine PMMA 
(PolyMéthylMéthAcrylate). 

L’essor de la Conception-Fabrication Assistée par Ordinateur (CFAO) a permis de 
développer de nouvelles chaînes de travail prothétiques, basées sur l’usinage de 
blocs de céramique ou de résine pour les prothèses fixées de type couronnes et 
inlay-onlays. Les bases des prothèses amovibles complètes peuvent désormais 
être conçues par impression de résine PMMA. Cette technique peut être appliquée 
à la réalisation d’orthèses palatines pour les nouveaux nés porteurs de division 
palatine.  

Après avoir décrit les deux protocoles de réalisation, traditionnellement versus par 
CFAO, nous discuterons des avantages et inconvénients des deux techniques. 
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1. Les plaques palatines obturatrices : 
1.1. Indications et contre-indications :  

La plaque palatine obturatrice est indiquée dès la naissance jusqu’à l’intervention 
chirurgicale (véloplastie et/ou palatoplastie) lorsque le nourrisson présente une 
division palatine ou vélo-palatine. [3,16] 

En cas de fistule séquellaire, il peut également être nécessaire d’utiliser une plaque 
palatine obturatrice si des troubles phonatoires et/ou alimentaires apparaissent. 

Pour les divisions labio-alvéolaires ou purement vélaires, la plaque palatine n’est 
pas nécessaire. [3] 

      
Figure 1 Fente du palais secondaire : A. Incomplète, B. Complète 

           
Figure 2 Fentes du palais primaire associé au palais secondaire : A. Unilatérale complète, B. Bilatérale 

complète, C. Unilatérale incomplète 

1.2. Intérêts : 

La plaque palatine obturatrice cloisonne les fosses nasales et la cavité buccale, ce 
qui permet de diminuer les reflux nasaux qui provoquent une irritation de la 
muqueuse nasale. La succion est aussi améliorée en permettant la création de 
pressions négatives intra-orales pour une meilleure alimentation. [3,12,15,16,21] 

De plus, la plaque évite l’interposition linguale dans la fente palatine en apportant 
un point d’appui. Ceci présente l’intérêt de faciliter la future intervention chirurgicale 
en évitant le phénomène de verticalisation des lames palatines. [13,15,16] 

Enfin, tout en créant des conditions optimales pour l’intervention chirurgicale, la 
plaque palatine obturatrice guide la croissance du maxillaire et réduit la 
déformation de la cloison nasale. [3,13,15,16] 
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Outre les bénéfices fonctionnels de la plaque palatine, celle-ci va également avoir 
un impact psycho-social. En effet, durant les premiers mois de vie, en attendant la 
phase chirurgicale du calendrier thérapeutique, la mise en place de la plaque 
palatine permet aux parents de s’impliquer dans le traitement et de mieux 
appréhender la malformation de leur enfant. Les rendez-vous réguliers instaurent 
une relation de confiance avec l’équipe soignante qui peut répondre aux 
interrogations des parents. [16] 

La plaque palatine obturatrice permet donc de normaliser les praxies linguales, 
diminuer le jetage nasal, guider la croissance maxillaire ; elle facilite ainsi le 
quotidien du nourrisson et de ses parents mais aussi l’intervention chirurgicale. 
Néanmoins, il est nécessaire de la renouveler régulièrement (tous les trois mois 
environ) en fonction de la croissance du maxillaire. [13] 
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2. Fabrication des plaques palatines traditionnellement en 
laboratoire : 
2.1. Empreinte au silicone 

- Elle est réalisée à l’état vigile, sans anesthésie locale, grâce à un porte-
empreinte individuel en résine (Ivolen®, Ivoclar Vivadent) et avec du silicone 
de type Xantopren® (Heraeus Kulzer). 
Le nourrisson est positionné en décubitus dorsal lors de l’insertion du porte-
empreinte puis est relevé en position semi-assise pour plus de confort 
respiratoire. Un corps gras tel que la vaseline est déposé sur les lèvres du 
nouveau-né afin de permettre une meilleure insertion du porte-empreinte. Le 
réflexe de succion du nourrisson permet de modeler l’empreinte. [3,15,16] 

 

2.2. Etapes de fabrication : 

- Réalisation de la plaque palatine obturatrice : après la 
coulée du modèle en plâtre, le prothésiste comble la fente 
palatine grâce à un punch de cire et trace les limites de la 
plaque sur le plâtre. 
Un séparateur est déposé sur le plâtre avant de réaliser la 
plaque en résine par additions successives de poudre de 
polyméthacrylate de méthyl et de monomère. Celle-ci est cuite 
pendant 10 minutes, immergée dans de l’eau chaude et sous 
pression (2 Bar) afin de limiter les porosités. [3,15,16] 

 

- Polissage et finitions : la plaque est polie, toutes les 
aspérités sont supprimées et les bords sont arrondis. 

  

Figure 5 Plaque passive sur le modèle 
d’une fente unilatérale totale 

Figure 3 Prise d’empreinte à l’état 
vigile avec un porte-empreinte garni 

de polyvinylsiloxane 

Figure 4 Empreinte d'une 
fente unilatérale totale 
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2.3. Matériaux utilisés : 

Les matériaux utilisés sont : 

- L’élastomère de silicone de moyenne viscosité (polyvinylsiloxane) de type 
Xantopren® (Heraeus Kulzer). : pour l’empreinte. Ses propriétés élastiques 
permettent d’éviter les déchirures et sa viscosité autorise une empreinte peu 
compressive des surfaces ostéo-muqueuses. [16] 

- La résine autopolymérisable orthoresin (Dentsply Detrey) de type poly(ethyl 
méthacrylate) de méthyl : pour la plaque palatine obturatrice. Le temps de 
manipulation est de 3min à 23°C et le temps de polymérisation est de 10min 
à 40°C. [9,16] 

 

2.4. Temps et coûts de fabrication :1 

Temps coulée du plâtre 
Temps de réalisation de la plaque 
 
Temps de cuisson 
Temps de polissage 

30 minutes 
20 minutes (punch cire + réalisation 
plaque) 
10 minutes 
20 minutes 

Total temps 1 heure 15 minutes 
 
Coût de la résine 
Coût matériel utilisé 

 
120€ les 500g soit 1,5€ la plaque (6g) 
Cocotte : 400€ 

Total coûts 4€ par plaque2 + investissement 
400€ 

 
  

 
1 Chiffres recueillis avec l’expérience des prothésistes de la faculté de chirurgie dentaire de Toulouse. 
2 Prix déterminé en intégrant la résine, le plâtre et l’amortissement du matériel type pièce à main, fraise 
résine, etc. 
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3. Fabrication des plaques palatines par impression 3D : 
3.1. Empreinte optique : 

Il existe deux possibilités pour la réalisation de l’empreinte optique : [9] 

- Directe : balayage optique intra oral du maxillaire par une caméra optique 
intra-orale 

- Indirecte : balayage optique de l’empreinte en silicone par un scanner de 
table ou caméra optique extra-orale 

Dans le premier cas, l’empreinte optique sera réalisée en introduisant la caméra 
optique dans la cavité buccale du nouveau-né. Cela évite l’utilisation de matériaux 
à empreinte (avec les risques de tirage lorsque l’enfant bouge beaucoup) et le choix 
d’un porte-empreinte adapté. Néanmoins la tête de la caméra étant relativement 
volumineuse dans la cavité-buccale d’un nouveau-né, l’accès à certaines zones 
telles que le vestibule ou la partie postérieure de la fente est difficile. A l’heure 
actuelle, le temps dédié à l’empreinte n’est pas raccourci avec l’empreinte optique. 
De plus il reste difficile pour un seul praticien de contrôler simultanément la 
progression du scan sur l’écran d’ordinateur et de surveiller le nouveau-né. Cette 
technique reste cependant prometteuse.  

Dans leur étude, K-F Krey et A Ratzmann, ont réalisé toutes les empreintes à l’aide 
d’une caméra optique. Cette technique serait mieux tolérée par les nouveau-nés 
grâce à la chaleur de la tête de caméra, néanmoins les zones postérieures ne 
pourraient pas être totalement enregistrées. Le logiciel OnyxCeph 3D Lab 
permettrait de combler automatiquement toutes les zones non enregistrées par la 
caméra optique. [13] 

L’empreinte optique peut être réalisée par un scanner de table ou une caméra 
optique en scannant soit le modèle en plâtre soit l’empreinte en silicone directement. 
En scannant l’empreinte, cela permet de s’affranchir des défauts de la coulée en 
plâtre de l’empreinte.  

Il existe différentes marques de caméra optique et de scanner de table. Nous 
utiliserons ici le scanner de table Ineos X5 de chez Dentsply-Sirona et les caméras 
optiques Planmeca-Emerald et Trios de chez 3Shape pour l’empreinte optique 
indirecte. Ces caméras fonctionnent sans poudrage. 
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3.2. Etapes de fabrication : 

3.2.1. Modélisation Meshmixer : 

La modélisation des plaques palatines peut être réalisée par diverses logiciels. 
Nous choisirons Meshmixer qui est un logiciel globalement complet et gratuit. [13, 
24] 

3.2.2. Raccourcis clavier : 

Clic Gauche Sélectionner 
Clic Droit Se déplacer dans l’espace 
Touche G Remplir la zone = expand to groups 
Touche Ctrl + clic 
Gauche 

Désélectionner une zone 

Touche Suppr Supprimer la sélection 
Ctrl + Z Revenir en arrière 
Clear sélection Tous désélectionner 
Touche Shift + < Etendre la sélection = expand ring 

 

3.2.3. Fiche technique : 

- Réalisation de l’empreinte optique de l’empreinte en silicone, grâce à un 
scanner de table ou directement du maxillaire par une caméra optique intra-
orale. 

- Ouvrir le fichier STL sur Meshmixer 
- Positionner convenablement le modèle .STL: Cliquer sur Edit puis 

Transform ; la position de l’empreinte peut ensuite être modifiée à l’aide des 
flèches. 

 

 

  



 
 

18 
 

Dans le cas où il s’agit d’une empreinte scannée, il faudra inverser la sélection pour 
obtenir un modèle positif : cliquer sur Select, sélectionner la zone grise puis cliquer 
sur G pour étendre la sélection. Ensuite, cliquer sur Edit puis Flip Normals. On 
obtient une inversion de la zone grise (voir image 6). 

 
 

- Supprimer les excès de l’empreinte : 

L’étape suivante consiste à supprimer les excès de l’empreinte optique. Pour cela, 
cliquer sur Select puis sélectionner les zones à supprimer et enfin cliquer sur 
Suppr. Recommencer la manœuvre jusqu’à élimination de tous les excès. 
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- Combler la fente labio-palatine : 

Cette étape permet de simuler la mise en place de la cire au niveau de la fente 
labio-palatine lors de la réalisation de la plaque de manière traditionnelle. Le but est 
donc de combler la fente. Pour cela, cliquer sur Select et sélectionner par petites 
zones les parties à combler. Cliquer ensuite sur Edit et enfin Erase & Fill. Une 
fenêtre apparait, elle permet de modifier les paramètres. Ici, on ne modifiera que le 
Bulge permettant d’augmenter l’épaisseur. Cliquer sur Accept pour valider les 
paramètres. Il est possible que cela provoque un « trou », dans ce cas il faut 
diminuer le paramètre Scale. En cas d’erreur, cliquer sur Clear Selection et 
recommencer. 

Poursuivre cette manœuvre jusqu’à l’obtention d’un comblement suffisant de la 
fente. Il est possible d’utiliser la même manœuvre pour combler d’éventuelles bulles 
ou contre-dépouilles qui empêcheraient la bonne adaptation de la plaque en 
bouche. 
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Une fois la fente comblée, il est possible de flouter/fondre les limites en utilisant les 
Brushes. Pour cela, Cliquer sur Sculpt puis Brushes et sélectionner Robust 
Smooth. Ensuite, cliquer sur les zones souhaitées en les balayant avec la souris. 

 

 

 

- Vérifier la conformité du modèle : 

Cette étape permet de faire l’analyse des défauts et donc de vérifier l’absence de 
trous, etc… Cliquer sur Analysis, puis Inspector et valider en cliquant sur Done. 
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- Tracer la plaque palatine : 

Pour cette étape, cliquer sur Select et tracer la plaque avec le curseur. Il est 
possible de diminuer ou d’augmenter l’épaisseur du trait du curseur en faisant varier 
le paramètre Size. Le tracé de la plaque sera de couleur orange. 

Dans le cas où l’on souhaite supprimer une zone déjà sélectionnée (en orange), il 
faut la sélectionner en cliquant simultanément sur la touche Ctrl et un clic Gauche 
sur la zone souhaitée. 

 
 

- Lisser les bords du tracé : 

Cette étape permet d’obtenir les bords du tracé réguliers. Cliquer sur Modify puis 
Smooth Boundary et Accept. 
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- Réaliser la plaque : 

L’étape de réalisation de la plaque est subdivisée en 2 parties. Dans un premier 
temps, cliquer sur Edit puis Offset. Régler les paramètres avec la distance à 0,2mm 
et décocher Connected. Cliquer sur Accept. 

 
  

La deuxième partie consiste en la réalisation d’un 2ème Offset. Répéter la 
manoeuvre en modifiant les paramètres de la manière suivante : distance à 1,8mm 
et Cocher Connected. Cliquer sur Accept. 

Le paramètre Distance permet de déterminer l’épaisseur de la plaque. 
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- Lisser la plaque : 

Cliquer sur Select puis cliquer sur l’extrados de la plaque et cliquer sur G pour 
sélectionner la totalité de l’extrados. Ensuite, cliquer sur Deform, Smooth et 
Accept. 

 
 

- Lisser et affiner les bords : 

Lors de cette étape, l’objectif est de lisser et d’affiner les bords de la plaque. Pour 
cela, cliquer sur Select afin de tout désélectionner, puis cliquer sur le bord de la 
plaque et cliquer sur G. Sélectionner la partie postérieure de la plaque et cliquer sur 
Shift + < ; 6 fois environ afin d’augmenter la sélection au niveau des bords. Ensuite, 
cliquer sur Deform puis Smooth et augmenter le paramètre Smoothing Scale à 
100, et enfin cliquer sur Accept. 
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- Séparer la plaque de l’empreinte : 

Cette étape permet de séparer la plaque de l’empreinte optique et donc de 
n’enregistrer que la plaque en vue de son impression. Cliquer sur Clear selection 
puis Edit et Separate Shells. Sélectionner la plaque seulement. 

 
- Enregistrer : 

La dernière étape consiste à enregistrer la plaque sous le format STL. Cliquer sur 
File, puis Export. Donner un nom au fichier et choisir le type STL ASCII Format 
(.stl) et enregistrer. 
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3.2.4.  Modélisation sur Netfabb : 

Le logiciel Netfabb de chez Autodesk est un logiciel gratuit. [13,25] 

- Sélectionner le plateau de l’imprimante 3D : 

Cliquer sur    puis sélectionner Way2production et cliquer sur OK. 

 

- Ouvrir le fichier STL et orienter l’objet à imprimer : 

Ouvrir le fichier STL puis orienter l’objet verticalement par rapport au plateau grâce 
aux flèches sur les bords de l’objet. Décocher Keep parts on platform afin de 
décoller la plaque du plateau. 
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- Créer les supports d’impression : 

Cliquer sur Edit support puis sélectionner l’onglet Support scripts, importer le 
« script Benoit » installé par l’équipe VOCO et cliquer enfin sur execute. 

 

Les supports principaux sont créés. Il faut créer des supports au niveau des zones 
rouges qui apparaissent. Clic droit de la souris au niveau de la zone rouge puis 
cliquer sur Create script-action support on cluster. Répéter l’opération autant de 
fois qu’il y a de zones rouges. 
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- Valider les supports : 

Cliquer sur analysis puis accept. 

 

- Dupliquer la plaque : 

Cliquer sur les touches du clavier Ctrl + X simultanément, puis duplicate. 
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- Déterminer l’épaisseur du matériau : 

Cliquer sur Setting puis modifier les paramètres : Layer thickness à 50µm et 
Support wall thickness à 300µm. Cliquer sur OK. 

 

- Créer le fichier à imprimer : 

Cliquer sur Create jobfile, cela va créer un fichier zip et attendre la fin du 
chargement. 
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Tutoriel vidéo : 
Voici la vidéo que nous avons réalisé afin de faciliter l’apprentissage de la 
modélisation d’une plaque palatine : « Tutoriel MESHMIXER pour la réalisation 
d’une plaque palatine pour un nouveau-né atteint d’une division alvéolo-palatine » : 
https://youtu.be/EYThJCiHzDQ 

     
                  Figure 6 Scannez avec votre mobile le QR 

Code 

 

  

https://youtu.be/EYThJCiHzDQ
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3.3. Matériaux utilisés : 

Nous utiliserons ici la résine V-Print Ortho (VOCO) avec l’imprimante 3D Solflex 
(VOCO). Cette résine contient de l’hydroxypropyl méthacrylate, tripropyleneglycol 
diacrylate, diphenyl (2,4,6-trimethylbenzoyl)phosphine oxide, polymérisable sous 
un spectre UV situé entre 378 et 388 nm. Elle a une grande résistance à la rupture, 
à l’abrasion, à la chaleur et est biocompatible. Ce matériau est un dispositif médical 
de la classe IIa qui est approuvé pour une utilisation illimitée dans la bouche. [27] 

Il existe d’autres résines indiquées en fonction de l’imprimante 3D utilisée. 

Pour l’empreinte en silicone, il sera utilisé le même matériau que pour la technique 
traditionnelle, c’est-à-dire un élastomère de silicone de moyenne viscosité 
(polyvinylsiloxane) de type Xantopren. Cette empreinte sera ensuite scannée afin 
d’obtenir une empreinte optique. 

 

3.4. Temps et coûts de fabrication : 

 

Temps de scannage optique extra oral 
Temps de modélisation Meshmixer 
Temps de modélisation Netfab 
 
Temps d’impression polymérisation 
 
Temps de polissage 

5 minutes 
20 minutes 
8 minutes (pour 4 plaques sur 2/3 
plateau) 
3 heures (pour 2 plaques sur 1/3 
plateau) 
3 minutes 

Total temps 3 heures 36 minutes 
 
Coût résine 
Coût imprimante 3D 
Coût scanner de table 
Coût caméra optique 
 
Coût logiciel 

 
400€ / Kg soit 5€ par plaque 
Entre 5 000 et 10 000€ 
20 000€ (sirona inEos X5) 
37 000€ (40 000€ trios ou planmeca et 
25 000€ condor) 
Gratuit 

Total coûts 5€ la plaque + investissement 
47 000€ 

[8] 
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4. Cas clinique : 
 

La plaque a été réalisée avec le Dr Emmanuelle Noirrit-Esclassan et le Pr Frédéric 
Vaysse. 

Il s’agit d’un nouveau-né vu en consultation au CHU Purpan, atteint d’une fente 
unilatérale complète gauche. Une première plaque palatine a été mise en bouche 3 
jours après la naissance. Puis trois mois plus tard a été réalisée et mise en bouche 
la première plaque palatine par impression 3D. 

 

4.1. Réalisation de l’empreinte : 

L’empreinte réalisée a été la même que pour la plaque palatine traditionnelle ; c’est-
à-dire par l’insertion d’un porte empreinte individuel en Ivolen remplit de silicone de 
type Xantopren. Le réflexe de succion a permis de modeler les bords de l’empreinte. 
Aucune anesthésie n’a été réalisée. 

   
Figure 7 Empreinte d'une fente unilatérale complète à partir d'un porte-empreinte en Ivolen et de Xantopren. 

 

4.2. Réalisation de la plaque palatine : 

Une fois l’empreinte obtenue, il y a deux possibilités : 

- La coulée du modèle en plâtre afin de réaliser l’empreinte optique 
- La réalisation de l’empreinte optique directement à partir de l’empreinte 

Dans les deux cas, l’empreinte optique peut être réalisée par une caméra optique 
ou un scanner de table. 

Ici, nous avons coulé le modèle en plâtre puis réalisé l’empreinte optique à l’aide 
d’une caméra optique Planmeca Emerald. 
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A.   B.  

Figure 8 A. Empreinte coulée en plâtre avec punch de cire. B. Empreinte optique avec caméra Emerald 
Planmeca. 

La modélisation de la plaque palatine est réalisée ensuite sur le logiciel Meshmixer 
et l’impression 3D via le logiciel Netfab. [24,25] 

A.   B.  

Figure 9 A. modélisation sur MESHMIXER. B. modélisation sur Netfab. 

Enfin son impression est réalisée grâce à l’imprimante 3D Solflex 350 de chez Voco 
avec la résine V-Print Ortho de chez Voco. [26,27] 

 

  
Figure 10 Imprimante 3D Solflex de chez VOCO et sa résine V-Print ortho 
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Figure 11 Plaque palatine obturatrice imprimée avec ses piliers 

   
Figure 12 Plaque palatine obturatrice avant et après polissage. 

Pour finir, il est nécessaire de polir les bords avant la mise en bouche de la plaque.  
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5. Discussion : 
5.1. Comparaison fabrication traditionnelle VS CFAO : 

Une étude a comparé l’usage des plaques palatines traditionnelles avec celles 
réalisées par CFAO : les plaques réalisées par impression 3D étaient bien ajustées 
et elles ne présentaient aucune différence d’usure par rapport aux plaques 
traditionnelles. De plus, elles ont été bien tolérées.[13] 

 

 CFAO Traditionnelle 
Temps Empreinte 4 min 30 min (coulée en plâtre) 
Temps de 
fabrication 

Modélisation 31 min 
45 min Impression 3 h 

Coût  Matériaux 5€ 4€ 
Matériel 47 000€ 400€ 

Total Temps 3H36 1H15 
 

Actuellement, la technique par CFAO a un temps de fabrication et un coût supérieur 
à la technique traditionnelle. Néanmoins, son temps de modélisation est 
relativement inférieur à la technique traditionnelle. En ce sens, l’impression ne 
nécessitant pas notre aide, le temps de fabrication reste donc inférieur. 

Concernant les coûts, l’investissement pour la technique CFAO est importante, mais 
permet de réaliser d’autres types de prothèses. 

 

5.2. Avantages et inconvénients pour le chirurgien-dentiste et le patient : 

L’imprimante 3D dans la pratique de la dentisterie peut être utilisée dans plusieurs 
catégories de soins : l’orthodontie, la prothèse et l’implantologie. Cette technique 
nécessite l’utilisation d’une empreinte optique au format STL et permet la production 
à la demande de pièces uniques d’une grande variété de produits qui sera 
personnalisée et sur mesure. 

Dans le cas des patients atteints de fente palatine, cette empreinte optique, qu’elle 
soit réalisée de manière directe ou indirecte, procure un gain de temps en 
s’affranchissant de la coulée du plâtre et évite la perte de précision de l’empreinte 
traditionnelle. De plus, s’il est possible de réaliser une empreinte optique directe, le 
risque d’un déchirement du matériau à empreinte au niveau de la fente est 
supprimé. [13] 

L’empreinte optique pourra ensuite soit être envoyée au prothésiste par 
l’intermédiaire d’un e-mail, soit être directement utilisée par le praticien pour 
modéliser la plaque. Ainsi, il y a un réel avantage environnemental car il n’y a plus 
besoin de coursier pour l’envoi de notre empreinte. [5] 

L’empreinte optique directe ou indirecte facilite l’archivage des données (comparé 
à l’archivage des modèles en plâtre). De plus, elle facilite son utilisation dans la 
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recherche sous réserve du consentement du patient (exemple : mesures 
anthropométriques). 

Après avoir modélisé la plaque sur l’ordinateur, on peut l’envoyer à l’impression. 
Malgré un temps d’impression long, il y a un gain de production car le temps de 
prototypage est considérablement réduit. De plus, lors de l’impression, il est tout à 
fait possible de réaliser d’autres tâches en attendant contrairement à la production 
d’une plaque traditionnelle. Pour le chirurgien-dentiste, il peut réaliser d’autres 
consultations et pour le prothésiste il peut réaliser d’autres travaux, ce qui permet 
un gain de temps. [5,6]  

Une imprimante 3D permet d’imprimer jusqu’à 5 plaques en même temps. Le temps 
d’impression avec l’imprimante Solflex de chez VOCO dépends du nombre de 
couches imprimées ainsi que des zones occupées du plateau d’impression (il y en 
a 3). Si on imprime 1 ou 2 plaques, on occuperait 1 zone du plateau, le temps 
d’impression sera identique, mais si on imprime 3 ou 4 plaques, le temps 
d’impression sera doublé car on occupera 2 zones du plateau. Il est donc possible 
de réaliser deux plaques pour deux patients différents sans allonger le temps 
d’impression. 

Pour que la vitesse d’impression soit plus rapide et que l’impression 3D devienne 
un réel compétiteur, il faudrait l’augmenter au centuple. [5] 

La modélisation nécessite une courbe d’apprentissage [13] et est opérateur 
dépendant, mais elle reste tout de même accessible ; la seule difficulté est de bien 
réaliser les limites de la plaque. Pour un technicien débutant, la notion d’épaisseur 
est plus facile à gérer avec le logiciel que manuellement. 

Les matériaux d’impression 3D ont un coût plus élevé que pour une fabrication 
traditionnelle mais l’impression 3D permet une réduction des coûts de production 
car elle n’utilise que la matière nécessaire à la fabrication de l’objet. Le matériau 
non utilisé pourra être recyclé dans la fabrication d’un nouvel objet. Il y a donc peu 
de perte de matière. [5,6] 

Les matériaux utilisés sont des matières lisses qui nécessitent peu de travail de 
finition et laissent une très faible quantité de résidus. Néanmoins, lors de 
l’impression par l’imprimante 3D, il est possible que des défauts apparaissent : le 
matériau peut être poli mais il est difficile à retoucher, en particulier par adjonction. 

En fonction des matériaux, il existe un vieillissement dans le temps, qui peut 
provoquer des déformations de la prothèse. Dans notre cas, les plaques sont 
renouvelées régulièrement ce qui pallie ce problème. De plus l’étude de K-F Krey 
et A Ratzmann, a montré qu’il n’y avait pas d’usure supplémentaire pour une plaque 
fabriquées par CFAO par rapport à une plaque traditionnelle. L’impression 3D 
permet une meilleure homogénéité et donc une meilleure solidité de la plaque 
qu’avec la résine polymérisée conventionnellement. [5,13] 

Pour le patient, outre le fait d’apprécier les nouveautés technologiques, il y a un réel 
avantage grâce à l’impression multiple qui permet d’obtenir plusieurs copies de la 
même plaque. 
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Le prothésiste aura donc une réduction des coûts de production et réduction des 
temps de finitions mais une augmentation du temps de productivité à cause d’un 
temps d’impression long.  

Finalement, une imprimante 3D est un réel investissement à long terme par son 
gain de précision et son gain de temps mais il faut avoir une vision à grande échelle 
pour avoir un gain de productivité. 

 

5.3. Limites de la CFAO dans la réalisation des plaques palatines : 

La CFAO est une grande avancée dans la technologie pour la réalisation des 
plaques palatines, mais elle comporte certaines limites. En effet, concernant 
l’empreinte optique, elle n’est possible aujourd’hui que de manière indirecte à partir 
de l’empreinte en silicone car les têtes des caméras optiques ne sont pour le 
moment pas adaptées à la taille de la cavité buccale d’un nouveau-né. 

Nous avions pu tester une caméra optique (Trios de chez 3Shape) néanmoins la 
taille de la tête de la caméra n’était pas adaptée à la cavité buccale d’un nouveau-
né. K-F Kreys et A Ratzmann ont également rapporté quelques difficultés pour 
enregistrer la zone de la fente. Certaines caméras optiques bénéficient d’une tête 
de caméra relativement petite mais il n’y a pas à ce jour d’études sur les nouveau-
nés et nous n’avons pas pu les tester. Cette technique nécessite donc encore 
quelques adaptations et reste très prometteuse. 

De plus, la modélisation sur logiciel est globalement accessible mais il faut tout de 
même prendre le temps d’apprendre à l’utiliser. 

Il y a également des limites financières concernant un investissement de cette 
envergure pour une imprimante 3D et une caméra optique ou un scanner de table. 
Lorsqu’un prothésiste dentaire ou un chirurgien-dentiste décide d’investir dans ce 
matériel, il ne faut pas se limiter à la fabrication des plaques palatines pour les 
nouveau-nés porteurs de fente palatines. Il y a de nombreuses autres applications 
pour une impression d’objets en 3D, comme par exemple la fabrication de gouttières 
(occluso ou ODF) ou encore des guides implantaires. Il est également possible de 
réaliser d’autres sortes de plaques palatines dans le cadre de la trisomie 21 afin 
d’améliorer les praxies orofaciales et de stimuler les muscles péri-buccaux des 
nourrissons et jeunes enfants. Posées précocement, elles doivent être portées 
plusieurs fois par jour pour favoriser la motricité linguale et sa capacité de 
discrimination sensorielle. La plaque comprend des stimulateurs palatins et 
vestibulaires qui peuvent être fixes ou amovibles (perles). [7,14] 

Le choix des matériaux imprimables reste pour le moment restreint avec un coût 
élevé (5 à 100 fois plus cher) dû à leur complexité mais aussi à l’avènement récent 
de cette technologie. Les distributeurs spécialisés sont encore peu nombreux. [5] 
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Conclusion : 
 

 

Depuis l’avènement de la CFAO en 1970, celle-ci n’a cessé d’évoluer. Aujourd’hui, 
il est possible de réaliser toutes sortes d’objets par impression 3D. Les fentes 
palatines touchant 1 nouveau-né sur 700 en France, nous avons voulu montrer qu’il 
était possible de modéliser et imprimer par CFAO une plaque palatine obturatrice. 

Krey KF et Ratzmann A, en élaborant entièrement des plaques palatines selon cette 
technique, ont pu démontrer qu’il n’y avait pas de différence d’usure ni d’adaptation 
entre celles réalisées numériquement et celles réalisées traditionnellement, avec 
une excellente tolérance par les nouveau-nés. [13] 

De plus, la technique de CFAO permet un gain de temps de fabrication pour le 
prothésiste mais également à long terme un investissement rentable au vu des 
diverses possibilités d’impression 3D (guide implantaire, orthèses, ODF…). 
Néanmoins, le recours à la CFAO nécessite un apprentissage de la manipulation 
du logiciel de conception ; la conception est rapide mais l’impression reste encore 
une étape longue lorsqu’il s’agit d’imprimer une seule plaque. Enfin, il est encore 
difficile de réaliser précisément une empreinte optique directement dans la bouche 
des nouveau-nés. 

Nous avons donc réalisé dans ce mémoire, une fiche technique et un tutoriel vidéo 
de modélisation et d’impression 3D d’une plaque palatine, afin de faciliter sa 
réalisation par les prothésistes dentaires et les chirurgiens-dentistes.  

Dans l’avenir, la vitesse d’impression devrait s’améliorer et la CFAO sera donc plus 
accessible. De plus, l’élaboration d’une tête de caméra optique adaptée à la cavité 
buccale des nouveau-nés serait la finalité de cette démarche. Elle permettrait de 
s’affranchir de l’empreinte en silicone ainsi que du scannage de l’empreinte, 
améliorant la précision de l’empreinte et apportant un gain de temps considérable. 
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Annexes :  
➢ Fiche technique de modélisation avec Meshmixer et Netfab : 

Raccourcis clavier : 

Positionner convenablement le modèle .STL 
Edit  => Transform  => modifier la position de l’empreinte à l’aide des flèches. 

 
Dans le cas d’une empreinte scannée, inverser la sélection pour obtenir un modèle positif : 
Select => sélectionner la zone grise en cliquant sur un point de sa surface puis cliquer sur 
la touche G => Edit => Flip Normals (voir image 6). 

 
 

Clic Gauche Sélectionner 
Clic Droit Se déplacer dans l’espace 
Touche G Remplir la zone = expand to groups 
Touche Ctrl + clic Gauche Désélectionner une zone 
Touche Suppr Supprimer la sélection 
Ctrl + Z Revenir en arrière 
Clear sélection Tous désélectionner 
Touche Shift + < Etendre la sélection = expand ring 
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Supprimer les excès de l’empreinte 
Select => sélectionner les zones à supprimer => Touche Suppr. 
 

 
 

Combler la fente labio-palatine 
Cette étape permet de simuler la mise en place de la cire au niveau de la fente labio-palatine 
lors de la réalisation de la plaque de manière traditionnelle afin de normaliser la morphologie 
palatine. 
 
Select  => sélectionner par petites zones les parties à combler =>  Edit => Erase & Fill. 
Modifier le Bulge permet d’augmenter l’épaisseur du comblement => Accept. 
En cas d’apparition d’un « trou » => diminuer le paramètre Scale. Si cela ne fonctionne pas 
=> cliquer sur Clear Selection et recommencer. 
Poursuivre cette manœuvre jusqu’à l’obtention d’un comblement suffisant de la fente et 
d’éventuelles bulles ou contre-dépouilles qui empêcheraient la bonne adaptation de la 
plaque en bouche. 
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Lisser les limites 
Sculpt => Brushes => sélectionner Robust Smooth => cliquer sur les zones souhaitées 
en faisant glisser le curseur. 

 
 

 

Vérifier la conformité du modèle 
Analyse des défauts et vérification de l’absence de trous, etc… 
 
Analysis => Inspector => Done 
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Tracer les contours de la plaque palatine 
Select  => tracer les contours de la plaque avec le curseur (trait orange). Adapter la taille 
du curseur en faisant varier le paramètre Size. Le tracé de la plaque sera de couleur orange. 
Supprimer une zone sélectionnée : sélectionner simultanément la zone avec le clic Gauche 
et la touche Ctrl. 
 

 
 

 

Lisser les bords du tracé 
Modify => Smooth Boundary => Accept. 
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Réaliser la plaque 
1. Edit => Offset. Régler les paramètres : distance 0,2mm ; décocher Connected => 

Accept. 
2. 2ème Offset : Edit => Offset. Régler les paramètres : distance 1,8mm ; Cocher 

Connected => Accept. 
 
Le paramètre Distance permet de déterminer l’épaisseur de la plaque. 
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Lisser la plaque 
Select => sélectionner l’extrados de la plaque (cliquer sur n’importe quel point de la surface 
puis sur la touche G). Deform => Smooth => Accept. 
 

 
 

 

Lisser et affiner les bords de la plaque 
Select : tout désélectionner => cliquer sur la tranche de la plaque puis sur G.  
Shift + < ; environ 6 fois afin d’augmenter la sélection au niveau des bords. Deform => 
Smooth => augmenter le paramètre Smoothing Scale à 100 => Accept. 
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Séparer la plaque de l’empreinte 
Clear selection => Edit => Separate Shells. Sélectionner seulement la plaque. 
 

 
 

 

Enregistrer 
File => Export. Nommer le fichier et choisir le type STL ASCII Format (.stl) => 
enregistrer. 
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Sélectionner le plateau de l’imprimante 3D : 

  -> sélectionner Way2production -> OK 
 

 
 

 

Ouvrir le fichier STL et orienter l’objet à imprimer : 

Ouvrir le fichier STL -> orienter l’objet verticalement par rapport au plateau grâce aux 
flèches aux extrémités de l’objet. 
Décocher Keep parts on platform : décoller la plaque du plateau. 
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Créer les supports d’impression : 
Edit support -> onglet Support scripts -> importer le script Benoit -> Execute. 
 

 
Les supports principaux sont créés. Créer des supports au niveau des zones rouges qui 
apparaissent.  
Clic droit de la souris sur la zone rouge -> Create script-action support on cluster. 
Répéter l’opération autant de fois qu’il y a de zones rouges. 
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Valider les supports : 
Analysis -> accept. 
 

 
 

 

Dupliquer la plaque : 
Touches du clavier Ctrl + X simultanément -> Duplicate. 
 

 
 

 



 
 

48 
 

 

Déterminer l’épaisseur du matériau : 
Setting -> modifier les paramètres : Layer thickness à 50µm et Support wall 
thickness à 300µm -> Ok. 
 

 
 

Créer le fichier à imprimer : 
Create jobfile -> fichier zip -> attendre la fin du chargement. 
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FABRICATION DES PLAQUES PALATINES PAR CFAO VERSUS 
CONVENTIONNELLEMENT 

 

 
RESUME : Certaines équipes pluridisciplinaires ont recours à la réalisation 
d’orthèses palatines néonatales en attendant la fermeture chirurgicale des fentes 
vélopalatines. Conventionnellement réalisées en polyméthacrylate de méthyl, la 
CFAO ouvre aujourd’hui de nouvelles perspectives. Malgré l’investissement 
financier important et l’apprentissage de la manipulation des logiciels de conception 
et d’impression, la fabrication de ces plaques obturatrices par CFAO permettrait un 
gain de précision ainsi qu’un archivage facilité. Nous avons réalisé une fiche 
technique ainsi qu’une vidéo tutoriel de modélisation et d’impression 3D d’une 
plaque palatine afin de faciliter sa réalisation par les prothésistes dentaires et les 
chirurgiens-dentistes. 

 

 

TITLE : Manufacturing palatal plates by CAD/CAM versus conventionally 
 

 

SUMMARY : Some multidisciplinary teams use neonatal palatal plates until the 
velopalatal clefts are surgically closed. Conventionally made of polymethyl 
methacrylate, CAD/CAM is now opening up new opportunities. Despite the 
significant financial investment and the need to train for new design and printing 
software, manufacturing palatal plates by CAD/CAM would enable better accuracy 
and easier archiving. We have therefore created both a technical sheet and a 
modeling and 3D printing tutorial video in order to facilitate its realization by dental 
technicians and dentists. 
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MOTS CLES : Conception et fabrication assistée par ordinateur (CFAO) ; plaque 
palatine ; impression 3D ; fente labiale et palatine. 
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